
 

How To: ADA Compliant PowerPoint Documents 

 

Criteria Checklist 

Here is a quick checklist for creating ADA compliant PowerPoints. You can click on 
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Reading Order 

The reading order is how a screen reader will read out a slide to a user. You want to 

make sure the order is correct as to not cause confusion for the screen reader user. 

Checking Reading Order 

To check the reading order, at the top of your screen go to “Review” and then choose 

“Check Accessibility.” 

 

The Accessibility check window will pop open on the right side and will show you which 

slides you should check the reading order for. From here, under the Check Reading 

Order section, click the drop-down arrow next to the first slide on the list and choose 

“Verify Object Order.” 

 



 

You can now see the reading order of your slide. *It reads from bottom to top. In the 

screenshot below, it will read Title 1, then Text Placeholder 2, then Text Placeholder 3, 

etc... You can click on each object for it to highlight inside the slide to show where it is. 

Once you checked that slide, you can click to the next slide in the list and the reading 

order should stay open. If it doesn’t, click the drop down again to select verify object 

order. 

 

*Important Note: If you are using PowerPoint 2021 or a newer version, your reading 

order will read from top to bottom. You can check what version of PowerPoint you are 

on by going to File in the top left corner and choosing Account. 

Alternate Text for Images 

When thinking about good design, visual elements are always a huge factor. This can 

cause issues for those using assistive technology. This is where alternate text, also 

known as “alt text,” comes into play. Alt text is used as a detailed description of an 

image. You want to describe the image as if you were explaining it to a blind person, 

pointing out the important and relevant parts of the image. If you are using an image for 



 

decoration purpose only and the image has no relevant information, you can use the 

“Mark as Decorative” option. *ALL images should have some form of alt text or is 

marked as decoration. 

 

Assign Alt Text: 

To assign alt text to an image, right click on the image. In the drop-down menu that 

appears, click on “Edit alt text.” Another option is to click on the image, then select the 

format tab in the top tool bar and choose “alt text” under the accessibility section. 

 

 



 

 

Alt Text Panel: 

The Alt Text panel will appear on the right side of your PowerPoint document. This is 

where you will enter your alt text or choose the mark as decorative option. There is also 

the option “Generate a description for me.” I would avoid this option as it does not insert 

acceptable alt text. If you decide to use this, be sure to edit any description to fully and 

correctly match your image. 

 

Reminder: Mark as decorative is *ONLY for images that convey no information; Images 

that are only used for a design purpose. If the image has any information that you want 

the students to have, it *MUST have detailed alt text. 

 

Unique Slide Titles and Blank Slide Option 

Every slide needs to have its own, unique title. A screen reader user has the option to 

view the slides by just the title and can use this as navigation. The title should be at the 

top of the slide and the first thing read out to the user (see Reading Order). There are 

some work arounds if you want to use the same title for multiple slides. For example, 

you have three slides and the title for all three are “Successful Relationships.” By putting 

(1 of 3) behind Successful Relationships in the first slide, (2 of 3) for the second slide 

and (3 of 3) for the third slide, this makes them unique slide titles. 

  



 

 

 

 

Avoid Blank Slide Option 

When it comes to creating a new slide in your PowerPoint, on the Home tab, under the 

slides section, you want to avoid choosing the blank slide option. The screenshot below 

highlights the quick way to insert a blank slide. Please avoid this option as a blank slide 

comes with no built-in accessibility. 

 

Instead, choose “New Slide” and then pick one of the slide templates provided to you by 

PowerPoint. The templated slides are there to help you with accessibility as they 

already come with correct reading order and a Title section. Title sections cannot be 

added into a blank slide and every slide requires a title section. If you are fixing a blank 

slide, you will need to convert it into a templated slide so it has a title section. 

 



 

 

Descriptive Hyperlinks 

Those that use assistive technology have the option to view a full list of links available in 

a PowerPoint. Using descriptive links is important so the user knows where the link is 

taking them and why. You want to avoid putting in a full URL because a screen reader 

will read out the “h t t p : / /” and that can be frustrating to the user. Descriptive 

hyperlinks tell the user what the link is about while also being short and to the point! 

*ALL links must be descriptive hyperlinks with the exception of email links 

Example Hyperlink 

For this example, I want to insert a link to our faculty resource page on the MSUTexas 

website.  

Instead of putting in the URL, which looks like this:  

https://msutexas.edu/distance/online-teaching-aids.php  

I am going to put it as a descriptive hyperlink, which looks like this: 

MSUTexas Faculty Resource Page 

This makes it a much shorter link and tells me exactly where I am going. 

Note: Do not use general phrases like “Click here” or “Read More” or “Learn More” for 

your descriptive text as this will give the learner no information about the link. 

Inserting a Descriptive Hyperlink 

To insert a link, you’ll want to type out the description that you want the link attached to. 

Once that is in place, highlight the description and then right click and choose “link” from 

the drop-down menu. 

 

https://msutexas.edu/distance/online-teaching-aids.php
https://msutexas.edu/distance/online-teaching-aids.php


 

The Insert Hyperlink window will appear. Paste your link into the “address” section and 

then press okay. Your text will now be a link, appear blue, and underlined. 

 

If you already have the hyperlink in the PowerPoint, you can change the text that it 

displayed. Right click your hyperlink and choose “Edit Hyperlink” from the drop-down 

menu. 

 

The Edit Hyperlink window will appear. In the Text to display box, put in the description 

for the hyperlink and press okay. 



 

 

Additional Link Rules 

• Website and email links must lead to the correct, active web destination or 

address. Links need to be corrected if they lead to a dead website, a 404 error, 

or a return to sender email address. 

• All links must be visually distinguishable from the surrounding text. The normal 

blue font with underline works for this criterion. 

Lists 

Lists are extremely helpful for those using assistive technology. It gives the user cues 

about the beginning of the list and the movement when going from one list item to 

another. Lists are also extremely valuable for visual learners and great for overall 

design. 

To create a list, simply highlight the text of choice and choose one of the two list style 

options under the Paragraph section on your top toolbar. Once the list is created, you 

can verify that it is a list by clicking anywhere inside of the list and you will see that one 

of the list styles will be grayed. This means that the list is utilizing that style. Anywhere 

you list 4 or more items should be correctly marked as a list. 



 

 

Tables 

Tables can be extremely challenging to assistive technology users if they are not set up 

correctly. *You want to be as simple as possible when creating a table. Tables need 

to include a header row, have no merged cells, and have no blank cells unless the table 

is being used for a student to fill the information in themselves, which is rare for a 

PowerPoint. 

Header Row 

To make sure the table has a header row marked, click anywhere inside the table and 

go to the “Design” tab on the top toolbar. In the top left corner of the design toolbar, 

under the Table Style Options, you will see “Header Row” with a box next to it. Make 

sure the box is checked. This makes the first row of your table the header row. 

PowerPoint does not work well with very complex tables so be as basic as possible if 

you use a table. 



 

 

 

Merged or Blank Cells 

Merged cells can cause issues for screen readers when it comes to lining up with the 

header row. Below is an example of a merged cell. *Do not use merged cells! 

 

Blank cells also cause issues for screen readers. A blank cell can cause confusion and 

lead to the user losing their place inside of the table. The user would then have to 

repeat the table to understand why there was a blank space. You do not want to leave 

any blank spaces. Best practice for a blank cell is to put either “N/A” or another type of 

signifier that tells the screen reader that there is nothing in that cell. The one exception 

where you can use blank cells is if you are creating a table that the student has to fill in 

information themselves. You will want to inform the user right above the table that there 



 

will be blanks present for them to fill in. Here is an example message: “Certain cells left 

intentionally blank for you to fill in on your own.” 

 

Video and Audio Files 

Video 

Videos require two things: Closed Caption and Descriptive Audio.  

Closed Caption 

The video must have closed captions. I would not recommend adding the video directly 

into the PowerPoint. Instead, I would link in a video from an outside source, such as 

YouTube. If your videos are inside of D2L, they cannot be linked into a PowerPoint. 

YouTube videos would be best for a PowerPoint, just make sure the video you are 

wanting to use has closed captions.  

Descriptive Audio 

The video should have descriptive audio. This means that the person speaking is 

explaining every thing they are doing in the video. The narrators typically describe 

actions, gestures, scene changes, and other visual information. They also describe 

titles, speaker names, and other text that may appear on the screen. This is important 

as a blind user will not get this information unless they hear it from the person speaking. 

Any important information you want a student to receive from a video, it must be spoken 

aloud. 

Audio 

If you provide audio only files, such as podcasts or speeches, you must offer a text 

transcript. This ensures that deaf or hard-of-hearing users can access the content. 

Make the transcript accurate, synchronized (if possible), and easy to locate on the same 

page. 

 

  



 

Color Contrast 

Color can be important to overall design but can cause issues for those with visual 

impairments or those who are colorblind. If you are using color, be sure to pick colors 

with high contrast. The rule to meet WCAG AA standards is a contrast of 4.5:1 for font 

below 18 points and 3:1 for font 18 points and above. *There are ways to check your 

contrast, which I will describe below, but if you want to avoid having to check 

each time then focus on having a light color font on a dark background or a dark 

color font on a light background. The more contrast, the better! 

 

Checking Color Contrast 

To check the contrast of a color, you will want to use Deque’s Color Contrast Analyzer. 

This website has three important areas: the foreground color, the background color, and 

the results. 

To change the color of the foreground and background, click on the box below the 

words “Color.” 

 

This will open a small window where you can pick your color. Click on the little dropper. 

This will allow you to use the dropper to select the color in your PowerPoint. It will give 

you a magnifying circle that you use to hover over the color in your PowerPoint. You will 

want to select the darkest color when using the dropper. Repeat this for the background 

color. 

https://dequeuniversity.com/color-contrast


 

 

Once you have selected both your foreground and background colors, you will see the 

results. You goal is to have the ratio be equal to or higher than 4.5:1. In the example 

below, the color we used has a 4.6:1 ratio, which is compliant. Our goal is to meet AA 

standards. If your color meets AA but does not meet AAA, it is still compliant. You do 

NOT need to worry about AAA standards. 

Note: The Deque contrast checker works best in Chrome and does not work well in 

Firefox. 

 



 

Emphasized Messages 

If you are trying to portray an important message to your students using Bold, Italic, 

Underline, CAPS, Highlight, or Color screen readers will not pick these up. To help the 

screen reader know that you are giving out important information, put a * in front of the 

message. So now it will be *Bold, *Italic, *Underline, *CAPS, *Highlight, or *Color. *It is 

up to your discretion if the message is important enough to earn a * or not. 

Here are a couple examples of sentences: 

• *ALL homework is due by the end of Friday. 

o This sentence seems very important, it should get a * in front of ALL as it 

is underlined and in caps. 

• There will be SOME people who do not want to wake up that early.  

o This sentence is not very important and the word SOME, even though it is 

in caps and bold, was used as a minor emphasis so it does not need a *. 

• Messages in color should almost always have a * with it unless the color is the 

main font of the PowerPoint or document. For example, if I put one sentence in 

red but all my other font is black then it needs a *. If my entire PowerPoint font is 

in a dark blue, there is no emphasis to be had so it does not need a *. 

• If you have an entire paragraph that is emphasized, best practice is to put *Note: 

or *Important: at the beginning of the paragraph. 

 

Transitions and Animations 

Transitions should be kept simple and avoid complex or automatic effects that could be 

distracting or difficult for assistive technologies. Transitions should not be used as the 

primary way to convey information and the duration should be brief (under 3 seconds). 

Avoid flashing, zooming, or spinning transitions, and ensure animations do not hinder 

the ability to read content. 

• Keep it Simple 

o Simpler transitions are generally better for accessibility. Complex 

transitions can be difficult for screen readers to interpret and can also be 

distracting for individuals with cognitive disabilities. 

• Avoid Automatic Transitions 

o Automatic transitions where slides advance at set intervals can be 

problematic, especially for those who may need more time to read or 

process the information on a slide. 

• Brief Duration 



 

o Transitions should be quick and unobtrusive. While some transitions can 

be useful for breaking up monotony, it's best to keep them brief (under 3 

seconds) to avoid disrupting the flow of information. 

• Avoid Distracting Effects 

o Avoid transitions that flash, zoom, spin, or otherwise create visual 

distractions that could interfere with comprehension or accessibility. 

• Ensure Animations Do Not Hinder Content 

o If animations are used, they should not obscure or remove important 

content from a slide. 

• Do Not Rely on Transitions and Animations for Information 

o Transitions and animations should not be used as the primary way to 

convey information. The main content of the slide should be easily 

accessible and understandable without relying on transitions and 

animations. 

 

Math Equations 

Math can be extremely difficult for screen reader users, especially if the document is not 

set up with them in mind. The best compliance for math equations will always be the 

built-in math equation tool. 

You can find the equation tool under the Insert tab in the top toolbar under the Symbols 

section. This tool will allow you to build just about any equation and it will read it 

correctly to screen readers. 

 

After clicking the Equation drop-down menu, you can choose a built-in equation or start 

a new one via the "Insert New Equation." 



 

 

Once you choose an equation you can click anywhere inside the equation. Doing this 

will provide you with a new toolbar that has many more math related options. 

 

If you are unable to build your equation with this tool, the backup option is to put the 

equation in as an image and then provide extremely descriptive alt text to the image. 

The alt text you provide should read as if you are verbally saying the equation to 

someone. 

For example: instead of using 3 x 2 in the alt text, you say 3 multiplied by 2. 

 



 

MathML 

You could look into MathML, which is a mathematical markup language for describing 

notation. The website provided will give you more information and includes tutorials and 

guides. MathML would be a great tool to learn if you use math a lot in your online 

courses. 

 

Language of Parts 

Documents will start with a default language. For most documents the default language 

will be automatically set to English. If you use any other language in your document, it 

must be marked correctly under preferences. This makes it so that a screen reader will 

read the new language in the correct dialect to the user. 

In this example, the second half of this paragraph is in Spanish. Since this is an English 

document I have to set the language preference of the Spanish sentences. 

 

Select the sentences that are in Spanish. Click on the Review tab in the top toolbar. 

Under the Language section click on Language. In the dropdown menu choose Set 

Proofing Language. 

 

https://developer.mozilla.org/en-US/docs/Web/MathML


 

A new language window will appear. From the options choose the correct language. For 

this example, I am picking Spanish (United States). Press Ok once you are finished. 

 

You will repeat this for any other sections where the language changes in your 

document. This must be done for full paragraphs, single sentences, single words, or 

even single letters if they are in a language different from the overall document. 

 

Accessibility Checker 

PowerPoint does have an accessibility checker but it is not very accurate when it comes 

to all the compliance requirements. *While I do recommend using it to see if you 

missed something, I would not rely solely on it. 

The accessibility checker can be found under the “Review” section on the top tool bar. 

After selecting “Check Accessibility” your results will show up in a window on the right 

side. PowerPoint will inform you of any mistakes it catches and give you information on 

how to correct it. 



 

 

 

Document Title and Saving 

Document Title 

Each file must have a descriptive title set in the properties. Document titles allow the 

user to know what the file is going to be about before they open it. If it is opened in a 

browser window, the name of that window will be taken from the document title. This will 

help the student recognize which browser window belongs to the file they just opened. 

To insert a document title, you go to File on the toolbar. Once this opens, it should 

default to opening the Info tab. If not, click on the Info tab. You will insert a title on the 

right side of this screen, under the Properties section, in the title box. Do not forget, this 

needs to be a descriptive title that lets the user know what the file is about based on the 

title you provide. 



 

 

Here is are some examples of good descriptive file names for a PowerPoint: 

• KNES 9876 Chapter 1 PowerPoint 

• ADA Compliance Week 2 PowerPoint 

• The Fall of Rome PowerPoint 

Saving 

Once you are finished your document as a PowerPoint file so that you will have the 

original version in case you need to make any changes. If you would like, you can also 

save the file as a PDF. PDF files are more universal but may lead to additional 

compliance being needed in the PDF file itself.  

To save, go to File -> Save As. Choose your location. First, I save it as a PowerPoint 

file, as it is easier to come back and make corrections. If you are wanting to save it as a 

PDF, click the drop down next to “Save as type” and choose PDF. After selecting PDF, 

click into the options menu. Under the include non-printing information section, verify 

that the following options are checked: 

• Document properties 

• Document structure tags for accessibility 

Hit save once finished. Saving this way will also save all compliance.  

*Note: Do NOT save through the “Print” option as this does not save compliance. 



 

 

*Note: PowerPoints do not convert to PDFs fully ADA compliant. In the PDF you will 

need to fix image reading order and header tags. If you want to avoid this, use the 

PowerPoint file instead of a PDF file. 

Additional Assistance 

If you need additional assistance, have ADA related questions, or would like to verify 

that you created an accessible PowerPoint document, send an email to 

zack.shanks@msutexas.edu. 

Created By: 

Office of Accessibility and Instructional Design 

Distance Education 
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